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INSTALLATION AND 
SYSTEM REQUIREMENTS 

System Requirements

PC running Windows® 7, Vista, XP, 2003/2008 Server, 2000, NT 4, ME, 98  (32 and 64 bit)
Screen resolution: 800 x 600 pixels or higher

Optional: To view the instruction as PDF-file, you will need to have Adobe® Reader 
installed on your computer.

Optional: To print individually designed receipts (optionally with your company logo), you 
will need to have Microsoft® Word 2000 or later installed on your computer
(e.g. in Office 2000, Office XP, Office 2003 or Office 2007).

Install KEY ORGANIZER

1. Insert the installation CD-ROM into the CD/DVD drive of your computer
    or use the downloaded installation program.

2. The CD contains a file named "Setup.exe". Double-click this file. 

3. Click "OK" to confirm the program installation.  

Once the installation is complete, you will find shortcuts (symbols) for the 
KEY ORGANIZER on the desktop and in the program menu. Clicking these shortcuts 
will start the program.

If you plan to use the KEY ORGANIZER program in a network with more than one 
workstation, please also read the chapter “Network Use”.

Software License

Unless otherwise agreed with the developer/originator, you will need an individual 
license to use the KEY ORGANIZER program for each workstation. 
All intellectual property rights remain with Rosenthal Software Development,
Jörg Rosenthal, Lippstadt, Germany.

To use the program, every user must agree to the program’s license agreement.
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BASIC PROGRAM FUNCTIONS

Any data entry into the KEY ORGANIZER is based 
on the same principle: 

You will find a command bar above the entry fields.
Depending on the available actions, this bar contains 
different administrative functions (e.g. New, Edit, 
Save, Cancel, Delete, Issue, etc.)

"New" will create a new data record and requires the 
entry of a new data set entry. "Edit" will set the 
selected entry to the editing mode that allows you to 
change existing data.

For easy identification of the editing mode, the entry 
fields of a data record that is in the editing mode are 
displayed in yellow. 

You can save the edited data record or cancel the 
action without saving changes (also by pressing the 
ESC-key). 

Caution: To avoid unintentional changes, a data 
record can only be changed if it is set to the editing 
mode with "New" or "Edit" and then saved / 
confirmed! For detailed information about filling in 
fields and the correct entry order please see the 
information pages dealing with the individual index 
cards.

"Delete" will remove the selected data record. 
Removed records will not be contained in lists any 
longer and cannot be used for new assignments and 
actions once they have been deleted. For some 
entries you will have to remove the link to other data 
records before you can delete the entry. 

Marker (behind "Lock Groups"): 
A group that is locked with the entry (in this case a 
specific key) has been directly assigned to the entry. 
Depending on the index card, the marker can also be 
placed behind the tab "Doors", "Cylinders", "Lock 
Groups", "Sub Groups" or on the button "Ground 
Plan". 

A marker always indicates that a link was set 
manually. You can display and edit these links using 
the functions "Change" and "Edit".

Extended Search With CTRL+F 
To open the extended search, select “Extended 
search” under "Edit" or press CTRL+F. "Extended 
search" will carry out a simultaneous full-text search 
of the following fields:  
EMPLOYEES Index Card: Name, Notes, 
Department, Number | BUILDINGS Index Card: 
Name, Address, Notes | DOORS Index Card: Name, 
Cylinder Properties, Notes, Room, Floor |
KEYS Index Card: Name, Key Type, Notes. 
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DATA BACKUP

Change Data Path 

The folder containing the KEY ORGANIZER 
database with all your entries is called "Data" and is 
by default stored on your local hard disk in the 
directory C:\Program Files\KeyOrganizer\Data 

If required, you can create another directory for the 
folder "Data", e.g. on a server, by selecting "Settings" 
under "Edit" in the program menu. 

CAUTION: Changing the directory will not 
automatically copy existing data to the new directory. 
The folder "Data" must be manually moved to the 
new directory.

Define Backup Frequency 

To determine whether and when to perform backups 
of your data, select "Edit" under "Settings" in the 
program menu. Since the backup files are very small, 
we recommend to perform a backup "daily after use" 
and to untick the checkbox in front of the entry "Ask 
user before each backup". 

Of course, it is up to you if you want to backup your 
data less frequently or not at all. But please keep in 
mind that you are responsible for the preservation of 
your data and that e.g. a hard disk defect might 
damage your data. For an optimum data protection, 
we recommend you to save your data externally (e.g. 
on CD-ROM) regularly in addition to the automatic 
program backup.

Determine Backup Path

To determine the backup path, select "Directories" 
under "Edit" > "Settings" in the program menu. By 
clicking "Change" you can select a folder. The folder 
can also be stored on another computer as part of a 
network (e.g. a server). This additionally increases 
the data security. 

Restore Existing Data Backup

Only take the following steps if you want to replace 
(defect) data with backed-up data. Do not restore 
data if not necessary as this will completely replace 
existing data with older data. You will have to copy 
some data manually.

1. Close the KEY-ORGANIZER. 

2. Use the Windows Explorer to open the data path 
where the program data is stored. The path can 
usually be found on your local hard drive in the folder 
C:\Program Files\KeyOrganizer\Data. The directory 
path can be found on the tab "Settings" under "Edit" 
in the program menu. 

3. Move the file "Data.ada", which is contained in this 
directory, to a safe place and store it there. This file 
contains your latest database information. 

4. Use the Windows Explorer to open the backup 
directory assigned to the KEY ORGANIZER under 
"Settings". There you will find two types of files: The 
first type starts with the word "data", the second type 
starts with the word "Log". The "Data"-files contain 
the database and their name also contains the 
creation date (in the format YYYY-MM-DD). 

5. From this directory, take the latest "Data"-file and 
copy it to the program data directory (from which you 
have removed the file "Data.ada"). Rename the 
copied file as "Data.ada" (i.e. delete the date 
specification incl. blank). 

6. In addition, copy all "Log"-files from your backup 
folder to the directory. It is not necessary to rename 
the "Log"-files. 

7. When you relaunch the KEY-ORGANIZER, the 
program will be reset to the latest backup status.
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PRINTING OF RECEIPTS

Issuance and return receipts are a documentary proof 
of key transfers. 

To edit the settings for the printing of receipts, select 
"Define texts for print-outs" under "Edit" in the program 
menu.

Printing Of Receipts As RTF-Files

KEY ORGANIZER uses "Rich Text Files" (RTF) as 
standard templates for the printing of receipts. These 
templates can be found in the folder "Forms" in the 
program directory.

You can adapt these files to your requirements. The 
texts contain wild cards that will be replaced 
automatically with the relevant data when being 
printed. 

RTF-files are slightly limited as regards their design 
flexibility and do not offer the possibility to use tables 
or images. If you have installed Microsoft Word on all 
of your KEY ORGANIZER workplaces, you can save 
the RTF-files as .DOC to use tables and images. 

Printing Of Receipts As Word-Documents

Alternatively to above-mentioned RTF-files, you can 
also use an individually created Word-document as 
print template for your receipts. This gives you the 
possibility to create your own receipts to the greatest 
possible extent, e.g. with your own texts and your 
company logo.

As a technical requirement, the word processor 
Microsoft® Word 2000 or later (e.g. Office 2000, Office 
XP, Office 2003 or 2007) must be installed on your PC. 

You will have to enter wild cards into the Word-
documents you wish to use as receipts. The KEY-
ORGANIZER will automatically fill these wild cards 
with the relevant data. As template for the creation of 
your documents please use the RTF-files stored in the 
folder "Forms". These files are stored in the KEY- 
ORGANIZER program directory (by default on your 
hard disk in the folder C:\Program Files\KeyOrganizer). 

You can rename your receipt templates and store 
them in a different folder. In this case, you have to 
specify the file names of your Word-documents in the 
KEY ORGANIZER program to divert the print-outs. 
To specify the file names, select "Define texts for print-
outs" under "Edit" in the program menu. Select the 
Word-file you created for the required form type by 
clicking "Search". Closing the window will save your 
settings.  

If the field "Print Preview" in the KEY ORGANIZER is 
activated, your documents will be displayed in the 
Microsoft® Word print preview. To print the documents, 
please also use the print function of Microsoft Word.

Wild Cards In Templates 

You can use the following wild cards in your RTF- or 
Word-documents. Most of the wild cards are already 
contained in the provided RTF-templates.  

Caution: Please adhere strictly to the exact spelling - 
without umlauts and without blanks between word and 
hashes.
You do not have to use all wildcards, e.g. you can 
leave out enclosures or notes if you do not need them.

#Key# 
Name of the issued or returned key

#System# 
Key system the key belongs to

#Notes1# 
Display of the notes field from key master data. The 
multiline note field is displayed as one combined line

#Notes2# 
Note entered in the handing over form when the key 
was issued or returned

#Date# 
Date of issuance or return of the key

#User# 
Logged-in user who handed over the key

#Person# 
Key recipient (key holder) 

#PersonDept# 
Field "Department" of key holder 

#PersonNumber# 
Field "Number" of key holder

#KeyCount# 
Number of keys

#KeyType# 
Type of key

#LockNumber# 
Lock number of the key

#Cabinet# 
Key cabinet of the key

#Hook# 
Hook number in the key cabinet

#Doors# 
Multiline listing of doors that can be locked with the key

#ActionVerb# 
Type of transaction

#SeqNumber# 
Sequential number of receipts / documents

#Subscriber# 
Database client

#Branch# 
Branch number of client
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IMPORT AND EXPORT OF DATA,  
DATABASE CLEAN-UP,
"SANDBOX" (PART 1)

To ease the transfer of already existing master data, 
the KEY ORGANIZER imports and exports data 
records as lists in the file formats .csv (Text), .xls 
(Excel) or .ods (OpenOffice).

This enables you to import and export e.g. data for the 
index cards “Persons/Employees”, “Keys” and “Doors”. 
Please also take notice of the corresponding 
information given in the help function of the program. 

If you already use a key system management program, 
it will probably be possible to transfer your existing 
data to the KEY ORGANIZER using individual import 
filters. In most of the cases, it is also possible to import 
digital data of the manufacturer of your key system. If 
you wish to import this kind of data, please contact us 
by e-mail.

Important Security Notes 

Since it is impossible to undo an import, we 
recommend you to back up your database prior to an 
import. To back up your database, select "Perform 
Data Backup" under "File" in the program menu. 

In addition, we strongly recommend you to make use 
of the "Sandbox Mode" (see next page). In the 
sandbox mode, you can check the result of an import 
without any effects on your original data.

Import List 

To import data, take the following steps: 

1. Convert your existing data into a tabular format, e.g. 
with Excel. Arrange the columns exactly as shown in 
the KEY ORGANIZER import window. 

2. Export the table you created as text or CSV-file. You 
can export these formats with a spreadsheet, e.g. 
Microsoft® Excel. Save the table as file type "CSV 
(Comma Separated Value) (*.csv)" or "Text (Tab 
Separated Value) (*.txt)". 

3. In the KEY ORGANIZER, select "Import" under 
"File" and then choose the data type you wish to 
import, i.e. doors, keys or employees. Click the button 
"Open File" in the import window. 

Check or uncheck the selection box to determine if the 
first row of your table contains titles. In the displayed 
table element you can then check if the columns of 
your table were assigned to the correct fields in the 
KEY ORGANIZER program. 

4. If the table preview shows that the values were 
assigned correctly, click the button "Perform import" 
and your table data will be transferred to the master 
data. 

Important Note: Prior to any import, we generally 
recommend to use the "Sandbox Mode" to check the 
import result (see next page). If the import does not 
produce the desired results, close the "Sandbox Mode" 
by pressing F10 or by logging out under "File" in the 
program menu. Try to import your data again with 
modified specifications in a new "Sandbox Session". 
Your original database will remain unchanged. 

If the final import into your original database (i.e. 
without "Sandbox Mode") did not produce the desired 
results, please read the information on "Data Backup" 
to recover your data.
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IMPORT AND EXPORT OF DATA,
DATABASE CLEAN-UP;
"SANDBOX" (PART 2)

Re-Import List / 
Update Data Records 

You can re-import an updated list. To import an 
updated list, the first field of each line, i.e. the 
description, must be exactly the same as the name 
stored in the program. For this data record, all fields 
that were created beforehand will be overwritten. 

Caution: All manual changes in the KEY ORGANIZER 
that have been done in the meantime will get lost at 
any rate!

Import Lock Plan Model 

With our standard import spreadsheet, you can collect 
data in Excel cells and import the data into the KEY-
ORGANIZER. In many cases, this is much faster than 
gathering data manually, because the data records are 
automatically linked. 

You can adapt this spreadsheet according to your 
requirements. Please download the file from 
www.key-organizer.net under "Download". The file 
contains a functional description and application 
information.

Database Clean-UP 

To clear-up your database after an unsuccessful 
import or in any other case, select "Special functions" 
under "Edit" > "Settings" in the program menu. There 
you will have the following options: 

- Delete persons without keys 
- Delete all persons 
- Delete all keys 
- Delete all doors 
- change key system assignments 
- assign specific keys of a key system to a key cabinet 
- create cylinders from door data (if cylinder lengths 
and positions were defined in the index card "Doors").

"Sandbox" 

In the IT industry, the term "Sandbox" describes a 
simulated environment where actions can be taken 
without any effect. 

The KEY ORGANIZER offers a "Sandbox" function, 
e.g. to check if the import of an Excel locking plan will 
be successful before importing the data to the original 
database. None of the changes done during a 
"Sandbox Session” will affect your original database. 

To open the Sandbox function, select "Sandbox" under 
"File" in the program menu and confirm the action. The 
program will then change to the login section, where 
you can choose a copy of your original database 
named "Sandbox". Select this entry and log in anew. 
The "Sandbox" mode is marked with an easily 
identifiable red border. 

You can now test any action, e.g. a data import. 

To exit the "Sandbox" mode, select "File" > "Logout" in 
the program menu. You can then re-login to your 
unaltered original database.
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NETWORK USE

The KEY ORGANIZER is fully network-compatible, so 
that you can access a shared data stock from several 
workstations at the same time. For security reasons, a 
data record (e.g. a key data entry) can not be edited by 
more than one user at the same time. 

Please note that the network use of the KEY- 
ORGANIZER program requires the purchase of 
additional licenses.

Technical Requirements 

To use the KEY ORGANIZER program in a network, 
you only need a shared directory on one of your 
computers that can be accessed by all PC-
workstations that have the KEY ORGANIZER installed. 

The shared directory is generally set up on a central 
server, but any "normal" PC with a correspondingly 
shared folder is absolutely sufficient. This network use 
has been successfully tested by us on a PC running 
Windows and also on a PC running Linux with the 
Samba-FileServer. The KEY ORGANIZER program 
itself, however, is a pure Windows application.

Configuring For Network Use

By default, the KEY ORGANIZER setup installs a 
single workstation, i.e. the folder containing the data 
can usually be found on the hard disk in the program 
directory C:\Program Files\KeyOrganizer\Data\
This data path has to be modified for network use.
Please take the following steps: 

1. Close the KEY ORGANIZER. 

2. Use the Windows Explorer to move the complete 
folder named "Data" to the server. The folder "Data" 
contains your latest database and can be found in your 
KEY ORGANIZER program directory. 

3. After having moved the folder, check the 
authorization rights for the folder "Data". All Windows 
users who are supposed to use the KEY-ORGANIZER 
must have read AND write access to the "Data" folder, 
even if a user is not supposed to have an authorization 
to make changes in the KEY ORGANIZER (see Index 
Card USERS). 

In the KEY ORGANIZER, the program users and the 
corresponding user rights are stored in a central 
database, so that you have to create a new user only 
once and centrally.

4. Launch the KEY ORGANIZER. On the settings-page 
("Edit" > "Settings"), select the path to your server and 
to the folder "Data"as new data path. 

5. The program will be closed automatically. Relaunch 
the program. From now on, the KEY-ORGANIZER will 
access your shared data stock via the network. 

CAUTION: 
The program directory containing the .exe-file should 
remain on the local PC in any case and should be 
locally started from there! Therefore, the shortcuts on 
the desktop and in the start menu will remain valid and 
active. The use via a terminal server is an exception. 
Here, the program will only be installed once and 
centrally.

Troubleshoot Potential 
Network Use Problems 

In the case of error messages being displayed due to 
missing write access when using the KEY- 
ORGANIZER in a network (although write access to 
the folder was correctly set up), the reason might be 
that a client was unable to finish a save operation (e.g. 
due to a Windows system crash). 

In this case, simply relaunch the KEY ORGANIZER of 
the respective client. This should solve the problem. If 
you do not know which is the correct client computer, 
you can check the file authorizations under Windows 
NT or Linux/Samba (using the Server Manager or 
SWAT) and read off the user of the file Data.wpf. This 
client then has to log on to its local KEY ORGANIZER 
again via the network (program restart while connected 
to the network).
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STEP-BY-STEP INSTRUCTION 

Correct data entry order

The KEY ORGANIZER gives you several possibilities 
to collect your data. This facilitates, for example, an 
easy on-the-fly entry of keys, doors and employees 
during each key issuance. This way, you can enter 
your data bit by bit. 

For users with a larger amount of keys, we would, 
however, recommend  
the more clear-cut and more professional key 
management using lock groups and cylinders. In this 
case, specific master data should be created 
systematically to save time. We recommend to take 
the following steps. 
The respective main aspects will be explained in the 
same order on the following pages.

Notes On The Simplification 
of Data Collection

In addition to the manual data collection described 
below, you can also collect your data in Excel cells 
with our standard import table and import the list into 
the KEY-ORGANIZER. In many cases, this is much 
faster than gathering data manually, because the data 
records are automatically linked. However, this 
process is not available to every customer and usually 
also requires manual revision. Please simply download 
the table from www.key-organizer.de under 
"Download".
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1 USERS Index Card > Page 11 
1.1. Create users 
1.2 Assign passwords 
1.3 Determine authorizations 

6

2 BUILDINGS Index Card > Page 12 
2.2 Create buildings / parts of buildings 

CYLINDERS Index Card > Page 17 
6.1 Create cylinders
6.2 Assign cylinder to door / doors in which the cylinder 

is mounted 
6.3 If the cylinder belongs to a key system and is part 

of a lock group, i.e. if the cylinder is locked not only 
with single keys but also with group keys: 
assign cylinder to a group 

7 EMPLOYEES Index Card > Page 18 
7.1 Create employees: Last name, First name 
7.2 Enter additional fields according to template (see 

above) 

3 (KEY) CABINETS > Page 13 
Index card > Page 16 
3.1 Create key cabinet 
3.2 Assign users with access authorization 
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4 DOORS Index Card > Page 14 
4.1 Specify door description 
4.2 Assign building 

5 (LOCK) GROUPS Index Card > Page 16 
5.1 Create groups 
5.2 If you plan to work with nested groups: Create sub-

groups first, then create main groups; then assign 
sub-groups to main groups 

KEYS Index Card > Page 19 
8.1 Create keys 
8.2 Select key system 
8.3 Select key type 

(optional, but one single master key (SMK) MUST 
be defined as master passkey (MPK) and will then 
automatically lock all cylinders of the system) 

8.4 Enter total number of keys 
8.5 Select key cabinet 

8.6.1 Single key: Assign cylinders 
8.6.2 Sub-master key: Assign lock group 

8.7 Save key 
8.8 Combine keys in bunches or distribute to several 

cabinets 
8.8 Issue key to employee 



USERS Index Card

Users are those persons authorized to use the program. The entire index card "Users" only 
requires the entry of one explicit name. The remaining fields are optional.

Password
For security reasons, we recommend to protect the program with passwords. 

Caution: A user, whose option "User + User Rights" is set to "Yes" is authorized to issue user 
passwords and can therefore grant him- / herself all rights. If you want to avoid this, set this 
option to "No" for the relevant user.

Determine Authorizations 
Specify the users' rights. You can determine authorizations for different key cabinets, e.g. a 
key cassette in the office and a key cabinet in the janitor's room.

Journal 
For security reasons, all changes are recorded in the user administration. This journal cannot 
be changed retrospectively. Open the journal by clicking the button top right or by opening the 
index card "Journal".

Both User And Key Holder? 
If a user is also a key holder, the user must be created twice in the program, i.e. as 
"Employee" and as "User".
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BUILDINGS Index Card

On the index card BUILDINGS, you can create all 
buildings or parts of buildings. 

Name & Name Affix 
Two fields are provided to enter a "Name": In the 
first and longer field, please enter only one short 
name (that will only be used once). In the second 
field, you can optionally enter e.g. an object 
number or the key system that is used. This 
description will be displayed in square brackets 
behind the name in the list view (e.g. [BKS]).

Assign Key System 
If you govern key systems with the KEY-
ORGANIZER, you can assign a key system to a 
(part of a) building here. "-" means that no system 
has been assigned. The selection "own key 
system" is of no relevance to the latest program 
versions. It is only still included for compatibility 
reasons and should not be used when creating 
new (parts of) buildings. Therefore, please select 
"-" for "no key system assigned" or select and 
specify the correct key system here.

Caution: You can only assign one key system to 
one entry in the category "Buildings / Parts of 
Buildings". If more than one key system is installed 
in one building, please enter the building data as 
parts of buildings, e.g. "Storeroom 1st Floor" and 
"Storeroom 2nd Floor" or similar. 

List of Doors 
This window displays the doors assigned to a 
building. Please assign doors to buildings later on 
the index card DOORS. Double-clicking one of 
these doors will directly open the entry for this door 
on the index card DOORS

12
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CABINETS Index Card 

The KEY ORGANIZER gives you the possibility to create different key cabinets 
and assign corresponding rights to the program users. 
For example, a member of the administration department can be granted 
authorization to govern the keys contained in the cabinet "Till" while not being 
authorized to govern the keys in the cabinet "Janitor's Room".

Cabinet Name 
A name may not be assigned more than once. 

Number of Trays, Columns, Rows 
The program does not (yet) evaluate this data. This information is reserved for a 
graphical display in future versions.

Specify Users with Access Authorization 
You need to be authorized to execute this command (see index card "Users").

13
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DOORS Index Card (Part 1)

On this index card, you can create doors and assign 
buildings, key systems and cylinders to these doors. 

Specify Door Name 
A name may not be assigned more than once per 
building. 

Assign building 
Here you can determine which building or part of 
building the door belongs to. Building data is entered 
on the index card "Buildings". 

Select the Cylinder's Key System 
If you wish to work with cylinders, select the cylinder's 
key system here. The selection "of building" is of no 
relevance to the latest program versions. It is only still 
included for compatibility reasons. Here, please select 
either "-" for "no key system assigned" or select and 
specify a key system. 

Select Cylinders 
If you have defined cylinders or if you wish to work with 
specific cylinders, you can select the cylinder 
corresponding to the door here. This approach has the 
advantage that you do not have to specify once more 
for each key separately that it (un)locks the 
corresponding door on the index card "Keys". 

(Un)Locking Keys and Persons 
Highlighting a door will display a list of results at the 
bottom. The list shows which keys (un)lock the door 
and which employees have such a key. Double-
clicking will directly open the relevant key entry on the 
index card "Keys".

Door Search According To Key Systems 
From this list, select for which key system the doors 
shall be displayed. If you enter a text into this field, the 
complete door database will be searched for entries 
containing the text entered as a part of their name. 

Door Search According to Buildings 
From the list, select for which building or for which part 
of a building the door shall be displayed. 

Floor and Room 
When entering a floor, please make sure to always use 
exactly the same spelling to guarantee that the field 
can be correctly evaluated. 
For example, always enter "Floor 1" and not once 
"Floor 1" and then "Floor-1". 

Import Doors 
You can let the KEY-ORGANIZER automatically take 
over your existing data by selecting "Import" under 
"File" in the program menu. 

>> Continue reading on the next page
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DOORS Index Card (Part 2)

Store Ground Plan

On the index card "Doors", the KEY ORGANIZER 
supports the use of images as ground plans. You have 
the possibility to store an image for each floor of a 
building or for each part of a building. 

The black marker indicates that a ground plan is 
stored. If there is no marker, no ground plan is linked 
to the data. 

Supported image formats 

If you use Windows XP or Vista, you can use ground 
plan images in the common file formats JPG, GIF, 
PNG, BMP and TIF. If you use an older Windows 
version, you can only use BMP or some JPG file types. 
If your ground plans are only available in other file 
formats, you will have to export your images from your 
program and convert them into a supported format. 
The program does currently not support links to other 
file types as e.g. AutoCAD drawings. 

The selected file will be automatically copied to the 
KEY ORGANIZER's data directory. This means that 
you may rename, move or delete your selected original 
file later without any effects on the display in the KEY-
ORGANIZER. 

How to embed the correct size 

The Key Organizer will take over the JPG image file at 
a ratio of 1:1 and will not change its size (width and 
height in pixels). Therefore, please select the size of 
your images in advance and set them to the scale they 
shall be displayed later on the screen when displayed 
at 100%. 
Current monitors support a resolution of 1024x768 
pixels or more.

Embed an image file 

To embed a ground plan, select a door in the 
KEY ORGANIZER for which a building or a part of a 
building has been selected and for which the field 
"Floor" has been filled in correctly. 

Clicking the button "Ground Plan" will then display the 
information on the left side of the screen that no 
ground plan has yet been stored. Under this 
information, the button "File" offers the option to "Add 
ground plan" when being clicked. Then you can select 
an image file from your hard disk. This image file will 
then be assigned to the building's floor.

For which doors will the ground plan be 
displayed? 

An assigned ground plan will be displayed for EVERY 
door that is on the same floor of the same building or 
part of a building. This means that the text entered in 
the field "Floor" must be identical for all doors drawn in 
on one ground plan. 

As soon as one door is assigned to the same building / 
part of a building and floor, the ground plan will be 
displayed for this door. This means that you only have 
to assign the ground plan once.
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LOCK GROUPS Index Card 

If required, you can create and govern your lock 
groups on this index card.

This time-saving feature is particularly recommendable 
if you want to display your locking plan in the 
KEY ORGANIZER or if you wish to professionally 
manage a large number of keys and cylinders. For 
example, the index card offers the possibility to assign 
a key to a lock group without  having to separately 
assign cylinders or doors that are (un)locked by this 
key. 

However, if you wish to work with lock groups, the 
manufacturer of your key system should have provided 
you with relevant data (locking plan or importable 
data). The benefit of a subsequent search for complex 
lock group data does in many cases not justify the 
effort.

Names of Groups
A name may not be assigned more than once per key 
system. 

Assign Key System
One lock group can only refer to one key system, since 
sub-master keys always belong to one individual key 
system. 

Assign Keys
Specify which keys belong to this group, i.e. which 
keys (un)lock the cylinders assigned to this group. 

Assign Cylinders
Here, please assign the corresponding cylinders to the 
lock group. The marker on the tab indicates that 
entries are stored. You can also assign the relevant 
cylinders to a group by using the index card 
"Cylinders". 

Assign Sub-Groups
Here you can assign already created lock groups as 
"sub-group". A sub-group may again contain its own 
sub-groups and so on. As soon as you have assigned 
a cylinder to a group, a key that (un)locks this cylinder 
can also (un)lock all sub-groups. This means that you 
can define a large number of interdependent lockings 
in only one work step. A missing marker on the tab 
indicates that no sub-groups were assigned here.

Multiple Assignment / Confusion
Particularly when no clear data is available, a program 
user might tend to create a multiple assignment of 
keys, groups, cylinders, etc. via different index cards. 

The KEY-ORGANIZER will treat these multiple 
assignments without error messages and exactly as 
you entered them. This means that you can work on a 
completely independent basis and that you can hardly 
go wrong with this. All links are "additive", which 
means that the locking possibilities add up. 

Redundant multiple assignments can, however, lead to 
a lack of clarity and considerable additional acquisition 
effort. The best way to avoid this will be an elaborate 
and consistent data recording strategy.
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LOCK CYLINDERS Index Card 

On this index card, you can govern your doors' lock 
cylinders. The creation of cylinders is particularly 
recommendable if you want the KEY ORGANIZER to 
professionally display a key system and a locking plan. 
Here, assign to your cylinders specific doors in which 
they are installed. You can additionally assign every 
cylinder to one or more lock group.

Name & Additional Name
Enter a lock name. A name may not be assigned more 
than once per key system. The entry of an additional 
name is optional. 

Key System
Select the key system the lock cylinder belongs to. 
Prior to this, you can specify the key systems with the 
menu: Edit > Key Systems.

Position
This entry typically refers to the sorting order in the 
locking plan. Fill in this field if you have corresponding 
data in hand and if these are of importance to you. 

Type, Coloring, Locking, Form
These fields are only supposed to be a memory aid for 
you and will not be automatically evaluated by the 
program. The field "Type" refers to single lockings 
("E"), additional lockings ("I" / "M") and central lockings 
("Z") and is in particular filled with corresponding data 
when importing KWD-data, provided that the KEY-
ORGANIZER supports the relevant KWD-format.

Doors
Specify in which doors this cylinder has been installed. 
If you have not yet entered any doors, you will have to 
specify doors first by using the index card "Doors". The 
marker on the tab indicates that a door has been 
assigned manually. If there is no black marker, the 
KEY ORGANIZER will automatically create the entries 
from existing links. 

Lock Groups
Here you can determine which lock groups this 
cylinder belongs to if you want to work with lock 
groups. If you have not yet entered any lock groups, 
you will have to specify corresponding groups first by 
using the index card "Groups". 

Disposition
Here you find discarded cylinders. You can discard 
cylinders by clicking the 1st data field under 
"Disposition" using the right mouse button and making 
your entries. 

Quantity ... available
Enter the number of cylinders manually. The program 
will automatically calculate the number of available 
cylinders from the total quantity less the installed 
cylinders less the defect or discarded cylinders.
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EMPLOYEES Index Card 

Govern "Employees", "Tenants", "Holders", 
"Customers" or "Persons" here. By selecting "Settings" 
under "Edit" in the program menu, you can determine 
which term to be used by the KEY ORGANIZER.

Extended Search With CTRL-F
The "Extended Search" under "Edit" will search the 
following fields of the EMPLOYEES index card: Name, 
Notes, Department, Number. At the same time, this 
command will search the index card BUILDINGS 
(Name, Address, Notes), the index card DOORS 
(Name, Cylinder Properties, Notes, Room, Floor) and 
the index card KEYS (Name, Key Type, Notes).

Name
A name may not be assigned more than once. 
Because of the alphabetical order, we recommend the 
entry variant "Last name, First name". 

Department
The term entered will automatically be taken over to 
the selection list (3), so that you can execute a quick 
search according to departments. You can change the 
lettering of this field in "Identifier" or "Customer no." in 
the "Department" settings (program menu at the head 
of the screen). 

Search Specification / Search Entry Field
From this list, select for which department the 
employees shall be displayed. 

If you enter a text into this field, all entries from the list 
of employees (5) that contain the text you entered as 
part of their name will be displayed cross-
departmentally.

Search In Buildings
From this list, select for which building the employees 
shall be displayed (if assigned).

Key Result List
The highlighted employee has the following key(s). 
Caution: You can only issue a key by creating this key 
first on the index card "Keys" and then passing it on to 
an employee.

Access Result List
With the key displayed on the left, the employee can 
(un)lock the following doors. The tab "Rooms" displays 
a summary of the room names belonging to the doors 
that can be (un)locked (please make the 
corresponding entries on the index card "Doors").

Journal
Click this button to open the index card "Journal" and 
to display all undeletably recorded transactions for a 
specific employee (e.g. create user, key issuance and 
return, etc.).

Insert Pictures Of Employees
Here you can store pictures of employees. Clicking 
them will enlarge the pictures. The maximum final size 
of the pictures is    229 x 285 pixels. If your pictures 
are larger, the KEY-ORGANIZER will automatically 
downsize them. Since all pictures will be copied to the 
program database, your original files will not be 
required any more afterwards (however, we 
recommend you to backup your image files anyway). 
Click the small symbol using your right mouse button 
to change and insert a picture.
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KEYS Index Card (Part 1)
This index card is one of the KEY ORGANIZER’s essential and central points. If you want to link keys to specific doors, 
cylinders, buildings or lock groups or if you want to issue these keys, it is necessary to record their master data 
beforehand. Please also note the processing sequence as described on the page “Step-By-Step Instruction”.

Key description
Use the first field to enter a key name. In case of need, 
the second field can for example be used for another 
distinguishing feature. The second field's content will 
be displayed in square brackets in the list view. 
The key name, which is a combination of both fields, 
may only be used once per key system. 

Assign key system 
Here you can assign a key to a key system. "-" means 
that no system has been assigned (e.g. for a car key). 

Key type 
This entry is optional and will not be evaluated. Only a 
passkey which (un)locks all cylinders of a key system 
MUST be defined as "GGMK".

You can make the following assignments: 
CK Change Key / individual key
SMK Sub-Master Key
MK Master Key
GMK Grand Master Key
GGMK Great Grand Master Key
EK Emergency Key
"I" and "M" (additional locking) 

Quantity 
When creating a key entry, enter the total amount of all 
of a key's copies, i.e. the total number of all available 
and issued original keys and duplicates. This figure will 
later change automatically when you re-order keys. 
It is also possible to change the number of keys at a 
later date. This will then be recorded in the journal. 
If you click the command "Inventory" using the right 
mouse button in the field "available" on the left, you 
can also change this field.

Assign Lock Group 
If you work with lock groups (see index card "Groups"), 
this is where you can define the lockings very easily 
without having to separately assign a cylinder or a door 
to the key. When a lock group has been assigned, the 
key automatically (un)locks the cylinders contained in 
this group and the doors where these cylinders are 
installed as well as the related sub-groups. 

Assign Cylinders 
This is where you can assign those cylinders to a key 
that are (un)locked by it. When creating a sub-master 
key and working with lock groups, you should not 
assign the key directly and manually, but assign the 
sub-master key to a lock group (see 5). 

Assign Doors 
This is where you can assign a specific door to a key 
that is (un)locked by it. Use this function only when you 
NEITHER work with cylinders NOR with lock groups, 
because otherwise this would imply an additional 
acquisition effort. When you assign a key directly and 
manually, a marker will be displayed on this tab 
indicating the direct assignment. 

Note: Overlapping lock groups, cylinders and doors 
can be assigned to a key without any difficulties or  
malfunction; all locking options will be added up. This,  
however, involves the risk that you lose track of the 
lockings and might not be able to reconstruct the 
creation context and relations of a locking. Therefore,  
we recommend a systematic and well-structured 
approach! 

>> Continue reading on the next page
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KEYS Index Card (Part 2) 

Here you will find further information about the 
functions provided by this index card. 
Please also read the preceding page.

Issuance Lists
Double-click an entry to change to this entry on the 
corresponding index card. 

Search Function 
Entering a term will initiate a search of the key list for 
the character string you entered. Entries matching your 
search term will be displayed or hidden during the 
search process. Your search term can be found at any 
point in the list. 

The program also offers automatically created search 
criteria, e.g. for key systems that have been created. 
You can select one of these search criteria in the pull-
down list. 

Issuance, Return, Loss 
Click these buttons to change directly to the index card 
"Handing Over". 

Important Notes on Program Modifications 
1. Since mid-2007, the list of key holders also contains 
a list of defect keys. 
2. To guarantee an auditing acceptability, the total 
number of keys will not be reduced if there are defect 
copies.
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KEYS Index Card (Part 3) 

Here you will find further information about the functions provided by this index card. 
Please also read the preceding page. 

Use Bunches of Keys
From Version 11/2006, the KEY ORGANIZER program supports the administration of bunches of keys. A bunch is based 
on the connection of single keys, i.e. the keys of one bunch must be individually created beforehand. The program will 
treat the bunches as individual keys.

1. Create Bunch Of Keys 

Select the index card "Keys" to create a new bunch of keys. On the index card, do NOT select the button "NEW", 
because this will create only individual keys. Instead, select "New bunch of keys" under "Edit" in the program menu. In 
the input mask, enter the name of the bunch of keys. The name should start with "bunch" to provide an easy 
identification and differentiation from individual keys at first glance. 

In the KEY-ORGANIZER, one bunch cannot occur more than once (therefore, the entry of a quantity is deactivated 
here), i.e. if required, several identical bunches will have to be created individually. 

Different from individual keys, it is not possible to create direct links between bunches and doors, lock cylinders or lock 
groups. Instead of these direct links, the bunch's locking options automatically result from the lockings of the contained 
single keys. 

Since creating a new bunch will not define the bunch's single keys, save the newly created bunch data record after 
having entered a name.

2. Add Key To A Bunch Of Keys 

Keys are added to a bunch with the issue / return mechanism similar to the mechanism used for the transfer of keys to 
persons. 

Select the key you want to add to a bunch. Press [Ctrl]+[m] to add the key to the marked list. Repeat this action to add 
more keys to the marked list if you want to attach more keys to the bunch. 

When the marked list contains all keys you want to add, select the bunch to which you want to add the keys. In the 
marked list, highlight all keys and click the button "Issue". You will then be asked if you want to issue the keys to a 
person or to the selected bunch. Confirm this message by clicking the button "Bunch". 

The program will now open the index card "Handing Over". On this index card, you will have to confirm the transfer one 
more time. This transaction does not contain the option to print a receipt. Delete the keys from the marked list to 
complete the transaction. 

3. Take Key From A Bunch Of Keys 

To take one individual key from a bunch at a later date, select the respective key in the list of keys and search for the 
bunch of keys in its list of holders. Click "Return".

4. Issue Bunches Of Keys To Persons 

Bunches of keys are issued and returned to key holders exactly in the same manner as single keys are issued and 
returned. 

To issue a bunch, first select a person, then select an available bunch of keys. Click "Issue".  

To return a key, select the bunch of keys, then select its holder and click "Return".

21



HANDING OVER Index Card 
This card contains the functions "Issue and Return", "Lost and Found" and "Defect and Repeat Order". This index card is 
normally opened from another index card, e.g. from the index card "Keys". Then the last activated key is already 
selected.

Help Texts 
When working with the KEY ORGANIZER, please take note of the individual detailed help texts for your program version. 
These texts will offer you any required additional information on the individual program functions and transactions. 

Specify Quantity 
Enter how many copies of a key you e.g. want to issue or take back. 

Old Stock and New Stock 
The program calculates these figures automatically. To guarantee an auditing acceptability, these figures cannot be 
altered. 

Printing of Receipts 
To create your own texts, select "Define texts for print-outs" under "Edit" in the program menu at the head of the screen. 

Specify Return Deadline and Notes 
Values entered here can be changed by selecting the respective employee (list down right) for the relevant key. 

Right-click the entry to select the command "Edit deadline + notes" and / or "Edit details". 

Multiple Issuance of Several Keys to One Person 
Open the index card "Keys" and select "Bookmarked Data Records" in the program menu at the head of the screen. This 
will open a separate window. On the index card, select the key you want to issue to a person and add it to the selection 
window "Bookmarked Data Records" by clicking the button "Add" or pressing the keys CTRL-M. To issue more keys to 
the same person, repeat this action. 

In the selection window "Bookmarked Data Records", select the keys you want to issue and click the button "Issue" to 
confirm. All keys will be issued simultaneously and will be listed on the issue receipt. 
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DEADLINES Index Card 

This index card will help you to keep an overview of when which user must return which key(s). 

Deadlines Result List 
If the return of a key or more keys is due, this list will be displayed every time the program is launched. 

Show Missed Return Deadlines 
Select: 
"to this day" 
"for the next 7 days"
"for the next 30 days"
and confirm your selection by clicking "Find".

Switch to Key / Switch to Holder 
Change directly to a key or a user from an entry, e.g. to return the key.

Edit Deadline 
To change a deadline you determined when a key was issued, select the respective employee (list down right) for the 
relevant key on the index card "Keys". Right-click the entry to select the command "Edit deadline + notes".
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JOURNAL Index Card

The KEY ORGANIZER's journal function is intended to be used for the monitoring of the program operation and for 
revisions. Therefore, journal entries cannot be deleted or changed in retrospect. 
The easiest way to open journal entries is to select a data record on the index card "Employees", "Users" or "Keys" and 
to click the button "Journal" top right. 

Search Field 
To search the list, either select an entry in the list or enter a sequence of letters. To display all entries, leave the field 
blank and click "Search". 

Use the "Time Travel Function" 
To See Data Of An Earlier Point In Time

In addition to journalizing important transactions (e.g. issuance or return of a key, changes in quantities, etc.) it may be 
necessary to display the state of the entire key management as it was at a specific point in time in the past. 

However, doing such an analysis with a journal list is not very practical. For this reason, a new function was added to the 
KEY ORGANIZER in March 2007. Now it is possible to display the state of the entire key management system as it was 
at a specific point in time in the past - including all existing links, keys, employees etc. of the desired date. 

When using the "Time Travel Function", you can use the KEY ORGANIZER as normal without changing your original 
database. 

Using the "Time Travel Function"

In the journal, select an entry, e.g. a key issuance or return, and click the button "Time Travel" at the bottom of the 
screen. 

This will open a new KEY ORGANIZER window highlighted with a yellow-orange frame. This window displays the state 
of the database as it was at the point in time of the selected journal entry. 

Unfortunately, it is not possible to go back to a date earlier than March 2007, since the "Time Travel Function" requires 
an internal storage of additional points in time, which could only be created for the first time together with the existence of 
this function. 
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